
803 – WEB APPLICATION – CLASS XI                                                                                        Page  1 of 9 

CBSE | DEPARTMENT OF SKILL EDUCATION 
 WEB APPLICATION (SUBJECT CODE -803) 

Blue-print for Sample Question Paper for Class XI (Session 2025-2026) 

PART A - EMPLOYABILITY SKILLS (10 MARKS): 

UNIT NO. NAME OF THE UNIT 

OBJECTIVE 
TYPE 
QUESTIONS 

SHORT ANSWER 
TYPE QUESTIONS 

TOTAL 
QUESTIONS 

   
1 MARK EACH 2 MARKS EACH 

  
1 Communication Skills - III 1 1 2 
2 Self-Management Skills - III 2 1 3 
3 ICT Skills - III 1 1 2 
4 Entrepreneurial Skills - III 1 1 2 
5 Green Skills - III 1 1 2 

TOTAL QUESTIONS 6 5 11 
NO. OF QUESTIONS TO BE 

ANSWERED 
Any 4 Any 3 07 

TOTAL MARKS 1 x 4 = 4 2 x 3 = 6 10 MARKS 

PART B - SUBJECT SPECIFIC SKILLS (50 MARKS): 
UNIT 
NO. 

NAME OF THE UNIT OBJECTIVE 
TYPE QUES 

SHORT 
ANS. TYPE 

QUES.- I 

SHORT ANS. 
TYPE QUES.-

II 

DESCRIPTIVE/ 
LONG ANS. 
TYPE QUES 

TOTAL 
QUESTIONS 

1 MARK 
EACH 

2 MARKS 
EACH 

3 MARKS 
EACH 

4 MARKS 
EACH 

1 Basics of Networking 7 
(Do any 4) 

1 - 1 9 

2 Website Building 
Using HTML and 
CSS 

9 
(Do any 8) 

1 1 2 13 

3 Multimedia Design 
Using GIMP 

7 
(Do any 7) 

1 1 1 10 

4 JavaScript Part 1 9 
(Do any 7) 

2 1 1 13 

TOTAL QUESTIONS 32 5 3 5 45 

NO. OF QUESTIONS  
TO BE ANSWERED 

Any 26 Any 3 Any 2 Any 3 34 

TOTAL MARKS 1 x 26= 26 2 x 3 = 6 3 x 2 = 6 4 x 3 = 12 50 MARKS 



803 – WEB APPLICATION – CLASS XI                                                                                        Page  2 of 9 

CBSE | DEPARTMENT OF SKILL EDUCATION 

 WEB APPLICATION (SUBJECT CODE -803) 

Sample Question Paper for Class XI (Session 2025-2026) 

Max. Time: 3 Hours        Max. Marks: 60 

General Instructions:  

1. Please read the instructions carefully.  

2. This Question Paper consists of 24 questions in two sections – Section A & Section 

B.  

3. Section A has Objective type questions whereas Section B contains Subjective type 

questions.  

4. Out of the given (6 + 18 =) 24 questions, a candidate has to answer (6 + 11 =) 

17 questions in the allotted (maximum) time of 3 hours.  

5. All questions of a particular section must be attempted in the correct order.  

6. SECTION A - OBJECTIVE TYPE QUESTIONS (30 MARKS): 

● This section has 06 questions.  

● There is no negative marking.  

● Do as per the instructions given.  

● Marks allotted are mentioned against each question/part  

7. SECTION B – SUBJECTIVE TYPE QUESTIONS (30 MARKS):  

● This section contains 18 questions.  

● A candidate has to do 11 questions.  

● Do as per the instructions given.  

● Marks allotted are mentioned against each question/part. 
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SECTION A: OBJECTIVE TYPE QUESTIONS 
Q. 1  Answer any 4 out of the given 6 questions on Employability Skills (1 x 4 = 4 marks) 

i. In a group discussion, Riya maintains eye contact, listens actively, and puts forward 
her points clearly without interrupting others. Which communication style is she 
using? 
a) Passive                                           b) Aggressive 
c) Assertive                                         d) Submissive 

1 

ii. Ritu has three assignments due this week. She makes a list of all tasks, sets 
deadlines, and starts with the most urgent one. Which technique is she applying? 
a) Procrastination                                b) Goal prioritization 
c) Avoidance                                        d) Multitasking 

1 

iii. Which of the following is the most important factor in team building? 
a) Mutual trust                                      b) Competition 
c) Self-promotion                                  d) Isolation 

1 

iv. Priya is writing a newsletter in MS Word. She needs to display page numbers at the 
bottom of each page. Which option will help her? 
a) Insert → Table                                 b) Insert → Page Number 
c) Layout → Margins                            d) Format → Bullets 

1 

v. An entrepreneur uses imagination and intuition to plan business strategies. Which 
attitude is this an example of? 
a) Risk-averse                                      b) Avoiding responsibility 
c) Passive approach                             d) Analytical and innovative thinking 

1 

vi. Which of the following is an example of a renewable energy initiative in India? 
a) Wind and solar power projects         b) Coal-fired power plants 
c) Diesel generators                             d) Petroleum exploration 

1 

 

Q. 2 Answer any 5 out of the given 7 questions (1 x 5 = 5 marks) 

i. Vimal and his sister are watching movies online at the same time on different 
devices. Suddenly, the internet becomes very slow. What is the most likely reason? 
a) Limited Bandwidth being shared      b) Incorrect IP Address 
c) Virus in the router                             d) Wrong Communication Channel 

1 

ii. Which attack involves faking a website or email to trick users into revealing 
sensitive data? 
a) Denial of Service                             b) Malware injection 
c) Phishing                                           d) Spam 

1 

iii. A hospital connects all its branches across different states for patient data sharing. 
Which type of network does this represent? 
a) LAN                                                  b) MAN 
c) PAN                                                  d) WAN  

1 
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iv. The part of an IP address that identifies the device within a network is called:  
a) Domain name                                     b) Host part  
c) Subnet mask                                      d) Network part 

1 

v. Which of the following best describes the word “Spam”? 
a) Sending unwanted bulk messages for advertising 
b) Flooding a server with fake requests 
c) Encrypting user files for ransom 
d) Monitoring user activity secretly 

1 

vi. In an office, several computers suddenly slow down and some files are deleted 
automatically. IT staff later finds that an infected USB was used. To prevent this in 
future, which tool is most useful? 
a) Switch                                        b) Router 
c) Antivirus                                     d) Repeater 

1 

vii A college website crashes during online admissions. Hackers had sent millions of 
requests to the server in a short time.Which type of attack does this describe? 
a) Phishing                                     b) Denial of Service (DoS) 
c) Malware injection                       d) Spam 

1 

 

Q. 3 Answer any 6 out of the given 7 questions (1 x 6 = 6 marks) 

i.  Which is the correct syntax for setting the background color in CSS? 
a) background-color: blue;             b) bgcolor: blue; 
c) color-background: blue;             d) color: background blue; 

1 

ii. Which attribute specifies the path of an image? 
a) alt          b) src                     c) title               d) href 

1 

iii. Which attribute opens a link in a new tab? 
a) target="_self"                             b) target="_open"  
c) target="_new"                            d) target="_blank" 

1 

iv. Which tag is used to link an external CSS file? 
a) <link rel="stylesheet" href="style.css">          b) <style src="style.css"> 
c) <css src="style.css">                                     d) <script src="style.css"> 

1 

v. Ravi wants to number his steps for a tutorial on the webpage. Which tag should he 
use? 
a) <ul>         b) <ol>                   c) <li>              d) <list> 

1 

vi. Ravi wants to embed background music in his webpage. Which tag should he use? 
a) <audio>  b) <sound>            c) <music>        d) <voice> 

1 

vii. Which tag is used to link an external CSS file? 
a) <link rel="stylesheet" href="style.css">          b) <style src="style.css"> 
c) <css src="style.css">                                     d) <script src="style.css"> 
 

1 
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Q. 4 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks) 

i. In GIMP, filters are used for: 
a) Creating text documents                      b) Resizing images 
c) Adding special effects to images          d) Saving files in different formats 

1 

ii. Which of the following is an example of a filter in GIMP? 
a) Bucket Fill                                            b) Rectangle Select 
c) Pencil Tool                                           d) Gaussian Blur 

1 

iii. The default background layer in GIMP is usually called: 
a) Base Layer            b) Background       c) Main Layer             d) Root Layer 

1 

iv. Varun used a tool in GIMP to select only a circular part of an image for editing. 
Which tool did he most likely use? 
a) Ellipse Select Tool      b) Crop Tool      c) Move Tool            d) Clone Tool 

1 

v. While working in GIMP, Simran adds text to her image. She notices that she can 
move or edit the text without affecting the background. Which feature of GIMP 
makes this possible? 
a) Filters                       b) Toolbox             c) Layers                d) Canvas Size 

1 

vi. Ravi creates a poster with three layers: background, image, and text. He 
accidentally hides the image layer. What will happen when the poster is 
displayed? 
a) Only background and text will be visible      b) All three layers will be visible 
c) Poster will be blank                                      d) Only the image will be visible 

1 

 

Q. 5 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks) 

i. Select the correct output of the following code: 

<script> 
var x = 10; 
var y = 20; 
alert(x + y + " is the sum"); 
</script> 

 
a) "10 + 20 is the sum"                                     b) "1020 is the sum" 
c) "30 is the sum"                                             d) Error 

1 

ii. Consider the following code: 

<script> 
for (var i = 1; i <= 13; i+=2) { 
    document.write(i + " "); 
} 
</script> 

How many times will the for loop be executed? 
a) 13                    b) 7                   c) 6                           d) 12 

1 
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iii. Consider the following code: 

<script> 
var name = ______("Enter your name:");  //missing statement 
alert("Hello " + name); 
</script> 

What statement should be given in place of the blank in #Missing Statement to 
take input from the user? 
a) input()           b) scan()                   c) read()                  d) prompt() 

1 

iv. Which of the following loops executes at least once, even if the condition is false? 
a) for loop         b) while loop             c) do…while loop    d) for…in loop 

1 

v. Which statement is true about JavaScript variables? 
a) Variables cannot store strings 
b) Variables must always be declared with var 
c) Variables can store different data types at different times 
d) Variables cannot change values once assigned 

1 

vi. What does parseInt("10") return in JavaScript? 
a) "10"            b) Undefined               c) Error                     d) 10 

1 

 

Q. 6 Answer any 5 out of the given 6 questions (1 x 5 = 5 marks)  

i. Which of the following expressions returns true? 
a) 5 > 10         b) 10 <= 10              c) 20 === "20"          d) 15 != 15 

1 

ii. Which statement is true about the switch statement in JavaScript? 
a) switch can only be used with numbers       b) Every case must end with break 
c) default is optional                                        d) switch cannot replace if…else 

1 

iii. Sita wants users to submit feedback on her webpage. Which tag should be used 
to create the form? 
a) <textarea>       b) <input>            c) <form>               d) <button> 

1 

iv.  In the CSS box model, which part lies outside the border? 
a) Padding          b) Margin             c) Content              d) Border 

1 

v. Neha wants to create a digital collage. She cuts different objects from photos and 
pastes them into a new file. Which two features of GIMP will be most useful for 
her? 
a) Filters and Zoom                                    b) Crop Tool and Rotate Tool 
c) Gradient Tool and Smudge Tool            d) Selection Tools and Layers 

1 

vi. If x = 10, what will x += 5; give? 
a) 5                    b) 10                    c) 15                     d) Error 

1 
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SECTION B: SUBJECTIVE TYPE QUESTIONS  
 

Answer any 3 out of the given 5 questions on Employability Skills (2 x 3 = 6 marks)  
Answer each question in 20 – 30 words. 
 

Q7  State two situations where written communication is more effective than 
verbal communication. 

2 

Q8  Aman uses a mobile calendar to set reminders for tasks. Identify the skill he 
is practicing and write one benefit of it. 

2 

Q9 How does the AutoCorrect feature differ from Spell Check? 2 

Q10  Define entrepreneurial values and give two examples. 2 

Q11  Why is E-waste management important for sustainable development? 2 

 
Answer any 3 out of the given 5 questions in 20 – 30 words each (2 x 3 = 6 marks) 
 

Q12 How does a Firewall protect a network? 2 

Q13 Differentiate between <input type="text"> and <textarea> in forms. 2 

Q14 Ravi is designing a poster in GIMP with three layers: background, image, 
and text. Why are layers useful in such editing? Give two points. 

2 

Q15  Identify the errors in the following code. Rewrite the correct code, after 
underlining the errors. 

var 1num = 10 
Let name = "Ravi"; 
console.log("Name is " + name 
if (num = 10) { 
    console.log("Ten"); 
} 

 

2 

Q. 
16 

Complete the code to print Sum of first five numbers in JavaScript: 
 
var i = _______;          // Blank 1: initialize loop variable 
var sum = 0;         
while (i ________ 5) {    // Blank 2:  
    sum = ________ + i;   // Blank 3:  
    i = ________;         // Blank 4:  
} 
console.log(sum);  

2 
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Answer any 2 out of the given 3 questions in 30– 50 words each (3 x 2 = 6 marks) 
 

Q. 17  Write CSS rules to: 
a) Change text color to red 
b) Add 10px padding 
c) Set background color to yellow 

3 

Q. 18 Riya clicked a photo for her school project, but the background looks too 
sharp. She wants to blur the background, enhance the brightness of the main 
object, and make the picture look artistic. Which three types of filters in GIMP 
can she use to achieve these effects? Explain briefly. 

3 

Q. 19 Rewrite the following code using a switch statement: 
 
var grade = "B"; 
if (grade == "A") { 
    console.log("Excellent"); 
} else if (grade == "B") { 
    console.log("Good"); 
} else if (grade == "C") { 
    console.log("Average"); 
} else { 
    console.log("Fail"); 
} 

3 

 
Answer any 3 out of the given 5 questions in 50– 80 words each (4 x 3 = 12 marks) 
 

Q. 20 A user wants to secure their computer from malware and unauthorized 
access. Suggest any four security tools and their functions. 

4 

Q. 21 Write HTML code to create a form that includes: 
● A text box for Name 
● A password field 
● A radio button for Gender 
● A submit button 

4 

Q. 22 1. Create a webpage with a heading “Save Trees” in green and center-
aligned, and a paragraph describing two ways to save trees. Add a 
2px solid border around the paragraph. 
 

2. Make a table with two environmental issues and their solutions. Style 
the table with 1px border, 5px padding, and center-aligned text. 
 

3. Display an image about Clean India Campaign. Below it, add a 
hyperlink “Learn More” that opens in a new tab and has blue color. 
 

4. Create a div with lightyellow background and padding 10px. Write 
“Say NO to Plastic” and highlight NO using span in red and bold. 

4 
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5. Make a paragraph about water conservation. Style it with font-size 

16px, Arial font, and 2px solid border. 
 
 
The sample output is given below 

 
 

Q. 23 Riya wants to edit her photo in GIMP. She needs to  
(i) select her face,  
(ii) crop the image,  
(iii) color a part of it, and  
(iv) add her name on it. 
Suggest four tools from the GIMP toolbox she should use. 

4 

Q. 24 Write a JavaScript program to accept a number from the user and check 
whether it is prime or not. 

4 

 


